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  Welcome to a slightly different issue of Full Circle Magazine.


  You might notice a few changes to Full Circle this month (understatement of the century). After nearly two years of the same layout and colours, we gave FCM a lick of paint. So, in come nice deep reds with a hint of peach. And I bet the new cover threw some of you off. Gone is the widescreen image, in comes a large full page photo with less text on the cover and even a redesigned logo, but, needless to say, we didn't stray too far from the design that most people seem to like. Where I did make a radical change is to the contents page. I hope this new page will be more informative to readers. I do hope you like the new design, if so, make sure you mention it to Slashdot. We want to be on that front page, and fulfill Robert's lifetime ambition.

  

  Why bring these changes in now? Because it's our birthday! FCM is officially two years old this month. I can hardly believe it! And to celebrate our second year, we've almost doubled the content this month! I know most of you would like FCM to be this big each month, but without more submissions it will be back to normal size next month. I can hear you all groaning, but we rely on your input to fill each issue. So please, take the time to write some articles on your favorite subjects. Just type it up in OpenOffice.org, attach the document, and some screenshots, to an email, and send it to my email address, which is listed below.

  

  Enjoy the issue, and I look forward to hearing what you think of the changes.

  

  All the best,

  

  Ronnie

  Editor, Full Circle Magazine

  ronnie@fullcirclemagazine.org


  

  



  Command & Conquer


  Written by Lucas Westermann


  This article will be dedicated to automating things you do every day, and to helping you create a backup solution that works for you. To begin, a “bash script” is a script that contains everyday bash commands, and some functionality that isn't used often from the command-line (such as if-then-else loops, while loops, etc.). Cron is a daemon that runs all commands listed in a user's crontab file (so if you want to run something that requires root powers, you need to edit the crontab for the root user). For the sake of this article, I will use a simple one-line bash script that condenses all the .java files in a folder into one text file. However, you could change it to condense log files. I will explain how the bash script works, and I will then cover how to set up cron to run the script every 6 hours.

  

  To create a bash script, the method I prefer is to write it using nano, so that's what I'll use in the examples. If you prefer a GUI editor, replace “nano” with “gedit” (minus the quotes). To start, do the following:

  

  nano FileCondenser

  

  This will start a new interface in the terminal with a completely empty file. Then enter the following lines (I will explain them in a moment):

  

  #!/bin/bash find $HOME/workspace/Year\ 11 -name '*.java' | while read line; do cat "${line}"; done

  

  Save the file with Ctrl+X, and hit Enter. To make the script executable, run the following command:

  

  chmod +x FileCondenser

  

  Now you can execute the script by running, in the terminal:

  

  ./FileCondenser

  

  or by creating a symbolic link to /usr/bin (and executing it like any other program you use in the terminal) by issuing:

  

  sudo ln -s /<path to script>/FileCondenser /usr/bin/FileCondenser

  

  where you replace “<path to script>” with the actual path (the absolute path is required for symbolic links).

  

  The script essentially uses find to locate all the files that end with .java in the eclipse folder, then pipes it (redirects the output) to the while loop, which states that while there is a line within one of those files to read, output the line, and once there are none, stop.

  

  As I mentioned above, you can change the path to /var/logs/, and have it read:

  

  find /var/logs/ -name “*.log”|while read line; do cat “${line}”; done

  

  which will condense all the files that end with .log from the /var/logs folder (and its subdirectories) and outputs it to the terminal. Or you can redirect the output to a file.

  

  To add the script to your crontab file, I'd suggest creating the symbolic link so the command is shorter, but that's not necessary. To edit the crontab file run the following command:

  

  crontab -e

  

  It will then open the user's crontab file. If you want to add it to the root user's crontab (for backup scripts and the like) run the following:

  

  sudo crontab -e root

  

  Once the crontab is open, it is important to know the format of the entry. It goes <minute> <hour> <day> <month> <day of week> <command>. All positions must be filled by either wildcards or values. A couple of examples:

  

  Every 5 minutes: */5 * * * * FileCondenser > $HOME/condenseFile.txt

  

  Every Sunday at 6: 00 18 * * sun FileCondenser > $HOME/condenseFile.txt

  

  The entry I'd suggest using for a periodic backup of logs would be:

  

  * */2 * * * FileCondenser > $HOME/condenseFile.txt

  

  which will run the script every two hours, and store the output in a file in your Home directory called condenseFile.txt. On a final closing note, a simple backup script that I can think of would be one that archives a certain folder, or collection of folders (like your home folder or your root directory), and stores it on a backup partition, or on an external hard drive, etc. An example for this would be:

  

  tar cvvzf /media/Backup/Music\ Backup/backup.tar.gz $HOME/Music

  

  This command assumes your backup hard drive/partition is mounted at /media/Backup and that it contains a folder called “Music Backup”. The tar command creates a gzipped tar archive at /media/Backups/Music Backup/ called backup.tar.gz, which contains the contents of your Music folder. You could run this command from a crontab without a script, but I would assume if you want to make system-wide backups (of your root partition, for example) you'd want to include a long list of folders to ignore - possibly reading the ignore list from another file; something like that, and so a script would just keep it clean. Not only that, but you could easily run it manually in the terminal as well. I recommend testing any commands or scripts on a small test folder before committing them, otherwise you may run into problems.

  

  Further Reading:


  Python version of the script for those interested: http://lswest.pastebin.com/m5b536464

  

  A bash script tutorial: http://www.linux.org/docs/ldp/howto/Bash-Prog-Intro-HOWTO.html

  

  Linux Shell Scripting with Bash by Ken O. Burtch (ISBN: 978-0-672-32642-4)

  

  Cron tutorial: http://www.clickmojo.com/code/cron-tutorial.html

  

  Lucas has learned all he knows from repeatedly breaking his system, then having no other option but to discover how to fix it. When he finds time, he publishes a blog at: http://lswest-ubuntu.blogspot.com.


  

  



  How To - Inkscape Part 1


  Written by Yoga Sukma


  This tutorial will show you how to go about making the Ubuntu logo using Inkscape. At this stage, I won't explain too much about the controls in Inkscape. I find it better to show how the tools work when we need them.

  

  Let's start

  

  Open Inkscape and make a circle with the circle button in the toolbar at the left side of the screen. Now make a smaller circle and put it in the center of the big circle. It should look like this:


  [image: ]


  Now we must combine the two. Hold SHIFT then click the circles one by one. Then select: Path > Difference. Now you have one circle which has a hole in the center.

  

  Draw a rectangle using the rectangle button in the toolbar. After you have a rectangle, click the rectangle and press CTRL+D to duplicate it. Make two duplicates, and place them as shown above right:


  [image: ]


  To rotate the rectangles, double click the object, which will then show eight arrows like the screenshot above. You can click and drag the arrows to position them as needed.

  

  Now hold SHIFT and click the circle, and then one of the rectangles. Then select : Path > Difference. Do it to the other rectangles. The results should look like this:


  [image: ]


  It looks more interesting now.

  

  Next, we need to add three smaller circles. Make a circle as you did before, and then duplicate it twice. Then position them like this:


  [image: ]


  Again, as before, we need to carve parts from our big circle segments. Hold SHIFT, select a big circle segment, then select one of the new small circles, and then Path > Difference. Do this for each new small circle. It should now look like the image (top left) on the following page.


  [image: ]


  Once more, we need three circles, but smaller than before. How? I know you can make them by yourself now. Position them like this:


  [image: ]


  We have an Ubuntu logo, but without color. We need to fill it with color, but first you must separate the parts of the logo. Select all of the objects by clicking CTRL+A, and then, from the menu, choose Path > Break Apart.

  

  Click the pieces one by one and then fill them with a color from the bottom toolbar. If you don't find the correct color, you can select Edit Object in the menu, and it will show you a new menu. You can select the correct color from it.

  

  Here's the final result:


  [image: ]


  It's better to save it as ubuntu.svg (or whatever you wish to call it), because next month we will give it a few nice touches to make it more snazzy-looking.


  

  



  How To

  Program in C - Part 8


  Written by Elie De Brauwer


  Computers and mathematics have always been best friends. Perhaps this is the reason why so many bugs exist. To illustrate, this article will work around a common problem known as overflow. As an example, we will work with the so called Fibonacci sequence, which starts with zero and one, and the next value in the sequence is calculated by adding the two previous digits. This means the sequence will look like: 0,1,1,2,3,5,8,13,21,... and it is immediately clear that this is an ideal job for a computer to generate. But there's a catch: these numbers get very large, very quickly. The Fibonacci sequence has some other interesting properties and various other, more efficient algorithms to generate a certain number.

  

  Finding limits


  
    01. #include

    02.

    03. typedef unsigned long long fibo_type;

    04. #define FIBO_FORMAT "%10llu"

    05.

    06. void printFibo(fibo_type num)

    07. {

    08.  printf(FIBO_FORMAT,num);

    09. }

    10.

    11. int main()

    12. {

    13.  int num=0;

    14.  fibo_type a=0,b=1,c

    15.

    16.  printf("%4d: ",++num); printFibo(a); printf("\n");

    17.

    18.  printf("%4d: ",++num); printFibo(b); printf("\n");

    19.

    20.  c=a+b;

    21.  while(c>=b)

    22.  {

    23.   printf("%4d: ",++num); printFibo(c); printf("\n");

    24.   a=b; b=c; c=a+b;

    25.  }

    26.  printf("Stopped after %d digits\n",num);

    27.  printFibo(c); printf("\n");

    28.  return 0;

    29. }

    

    Listing 1: Fibonacci.c
  


  In Listing 1, a small application is shown where the main loop (lines 11 to 29) defines three variables a, b and c, which will contain the previous, current and next number of the Fibonacci sequence. In each iteration the numbers are shifted, and a new next value is calculated. There is, however, one odd thing - the condition of the while loop on line 21. It reads 'c>=b', but c equals b+a so from a mathematical viewpoint this expression is worthless since it will always be true.

  

  However, this application isn't running in a mathematical utopia, it is running inside a computer, and this means that, in the case of a 32 bit unsigned integer, if you add one to 0xffffffff, the result will be 0x0. This means an overflow has occurred, the new value cannot be expressed using only 32 bits (0x100000000), and the result has been calculated modulo-32 bits (0x100000000&0xffffffff=0x0). In other words, a wrap has occurred. The same happens when working with signed values, but here you will overflow the sign bit first, and you will end up with a large negative value.

  

  On line 3 and 4 there is a definition of a fibo_type and a FIBO_FORMAT. These are used to easily modify the application to other datatypes. This way it is possible to experiment where the boundary lies when using a signed value or a short. In the case of an unsigned long long, this application is able to calculate 94 Fibonacci numbers.

  

  One could also experiment using floating point numbers, which have access to a larger range. But keep in mind that one looses precision. This can be even more dangerous since the number appears to be correct but in fact isn't (if in doubt ask the people who wrote the Ariane 5 rocket software).

  

  Conclusions so far: It's nice that there are an infinite number of integers. Wouldn't it be nice if we could be able to actually use all of them?

  

  Breaking limits

  

  Well, actually we can use them all, but there will be a price in efficiency. Adding two 32-bit values is bleeding fast, in fact a simple assembly instruction is able to do the trick, but then again you're stuck with the 32-bit limit (this may vary depending on cpu type, but there will be some limit). But there's a work-around. Instead of using an integer we could use an array and implement the addition ourselves, simply by doing it the same way we learned to do it in primary school: and one digit at a time, bring carry into the calculation, etc. For addition and subtraction, this can be done, but once working with multiplication, division, and square roots, things are getting rather tricky, and it gets very unlikely that they will be implemented efficiently. Adding two digits is as efficient as adding two integers, so adding two four-digit numbers the manual way is at least four times slower than the integer version.

  

  Now, luckily we live in an (at least for a part) open world, and we are not required to reinvent the wheel ourselves. There is a library called GMP (GNU Multiple Precision Arithmetic Library, see http://gmplib.org), which offers all this functionality and much, much more, and all we need to do for it is type sudo apt-get install libgmp3-dev. This library offers us a lot of functionality, but, in this article, we'll only scratch the surface a little. I strongly encourage the reader to take a look at the API documentation at http://gmplib.org/manual/ to see the possibilities this library can offer you.


  
    01. #include <stdio.h>

    02. #include <stdlib.h>

    03. #include <string.h>

    04. #include <gmp.h>

    05.

    06. int main()

    07. {

    08.  int num=0;

    09.  mpz_t f_1;

    10.  mpz_t f_2;

    11.

    12.  mpz_init(f_1);

    13.  mpz_init(f_2);

    14.  mpz_set_ui(f_1,0);

    15.  mpz_set_ui(f_1,1);

    16.  printf("%10d: 0\n",++num);

    17.

    18.  while(1)

    19.  {

    20.   mpz_add(f_1,f_2,f_1);

    21.   mpz_swap(f_1,f_2);

    22.   char * res = mpz_get_str(NULL,10,f_2);

    23.   printf("%10d: %s\n",++num, res);

    24.   free(res);

    25.  }

    26.

    27.  mpz_clear(f_1);

    28.  mpz_clear(f_2);

    29.  return 0;

    30. }

    

    Listing 2: Fibonacci2.c
  


  Listing 2, which can be compiled with the command:

  

  gcc -Wall -lgmp Fibonacci2.c -o Fibonacci2

  

  shows an implementation of the same algorithm, but now it uses GMP. Lines 12-15 initialize a container, and set the container to a certain value. Behind the scenes, GMP allocates storage for you, and performs all the needed bookkeeping. Lines 18 to 25 show the main loop, which will never terminate. Here the mpz_add function is used to add two integers and store the result in an mpz_t. This replaces the c=a+b. And mpz_swap is used to get the order right. We only use two variables here and one swap, instead of three variables and two swaps we used in Listing 1. The second part of the while loop, lines 22-24, creates a base-10 string representation of the mpz_t, prints it and frees the storage (note: there is room for improvement here, see exercises). Lines 26-30 are unreachable code, but they illustrate how the internal structure should be cleared. This clearly states how powerful this library is. From a programmer's perspective, all we need to do is replace our initialization of our variables, and replace the addition by a library call. Behind our backs, the library took care of everything. But keep in mind that these 'simple' additions are in fact rather heavy computations, and it would be a bad idea not to use an integer for num.

  

  Now this application will give us a truly eternal (well actually num will overflow after 2^31 Fibonacci digits) feed of Fibonacci numbers in a style what would only envy The Matrix.

  

  Exercises

  

  • Try running the application for all different data types in Fibonacci.c, signed and unsigned versions of char, short, long and long long, and try to pinpoint their limits.

  

  • Try the same using floating point data types in Fibonacci.c. Do you get more numbers? Are they correct? Where do things start going wrong?

  

  • Skim through the GMP api documentation and get familiar with the possibilities of the library.

  

  • Read the GMP manual, and search for help on mpz_get_str. Now, rewrite Fibonacci2 so that memory is not allocated and freed every time, but is reallocated when more digits are required.


  

  



  How To - Spread Ubuntu Part 3


  Written by Grant Paton-Simpson


  Someone you know wants to make the switch from Windows to Ubuntu. Or perhaps you are finally ready for that transition yourself. This article provides some practical help. Although I can only scratch the surface in a short article, there are links to more information where possible.

  

  Setting up a clean install of Ubuntu is very easy. Setting up a dual boot arrangement is not much harder. The trickier part is setting up a new Ubuntu system with a user's legacy files, emails, bookmarks, etc. What follows covers some of the main issues I have faced so far and how to resolve them. The skills/effort required range from beginner to advanced. I won't have the space in this article to explain all the details for intermediate or advanced tasks.

  

  My examples all assume Firefox as the web browser, and Thunderbird as the email client. Although this will not always be the case, the Windows users I have dealt with have usually been using these already, which makes the transition of Operating System (OS) easier. You may wish to consider Evolution instead.

  

  Preparation

  

  A cheap, modern, but reasonably long Ethernet cable can be extremely useful for shifting files around. And a portable USB hard drive (or large USB stick) can also help, especially if either of the machines lacks a network port.

  

  Backup (intermediate)

  

  If you want to backup only a subset of the files on your Windows machine, you can simply copy them onto a large USB stick. I would recommend, however, taking a full copy of every single file on the machine. This is especially important if the machine is being wiped. You never know what you will need later. An obscure setting could turn out to be critical, and it may take many months before the need becomes apparent. And can you really be confident you have every photo, music track, configuration setting, etc.?

  

  Assuming you want to make a full backup as detailed below, you will end up with a folder called “fromwin”. Exactly how you shift your files around and store them in their final destination will depend on whether you are changing OS on the same machine or switching from one machine to another.

  

  Scenario 1 Two networked machines

  

  Give the destination Ubuntu machine a static IP address, install sshd onto it (sudo apt-get install openssh-server) so we can transfer files to it using ssh (see http://p-s.co.nz/wordpress/?p=35), and boot into the Windows machine with a Live Ubuntu CD. From the terminal of the Live CD, use the following command to copy all the contents of the Windows machine to a folder on the Ubuntu machine called “fromwin”:

  

  scp -pr /media/disk1 username_on_dest@ip_address_of_dest:~/fromwin

  

  NB replace username_on_dest with the user name e.g. john, and ip_address_of_dest with the IP address of the destination machine e.g. 192.168.1.188.

  

  NB you might use variants of this approach to shift data from a Windows machine onto a temporary location on a Ubuntu machine, wipe Windows on the original machine replacing it with Ubuntu, then shift the data back (same machine but different OS). I leave this as an exercise for the reader.

  

  Scenario 2 Two machines with USB

  

  If there is no Ethernet port, you can use a USB HDD as the intermediary. Copying onto this from a DOS prompt is easy enough - if you know the command. Assuming the drive letter assigned by Windows for the USB drive is G:

  

  mkdir G:\fromwin

  

  xcopy C:\*.* G:\fromwin /c /d /s /h /r

  

  NB You should verify that the target location does contain all of the necessary files, and folders.

  

  You can now copy this data across to its final destination when required. The USB drive can also become a permanent backup of the original system if you want.

  

  Making “fromwin” Read Only

  

  Once you have transferred all the data, make the “fromwin” folder read only. Copy files from it to other parts of the Ubuntu file system as required, but it is best to leave it intact unless there is a shortage of hard disk space. It can be surprising which files you need later down the track.

  

  Email/Calendar (intermediate/ advanced)

  

  When setting up Thunderbird and Firefox, you will need to view hidden folders. Inside Nautilus, use ctrl-h to display hidden folders (they start with a dot such as, for example, .mozilla-thunderbird).

  

  If the user previously had Thunderbird on the Windows machine, you will need to shift the address book and email across. For the address book, copy the file abook.mab from fromwin … /Documents and Settings/user_name/Application Data/Thunderbird/Profiles/gobbledegook.default/” to /home/user_name/.mozilla-thunderbird/gobbledegook.default/. The gobbledegook could be something like at4d26v.

  

  The Windows location for mail is Documents and Settings/user_name/Application Data/Thunderbird/Profiles/gobbledegook.default/Mail. See http://p-s.co.nz/wordpress/?p=35 for more details.

  

  There are a few gotchas setting up Lightning and transferring across existing appointments. See http://p-s.co.nz/wordpress/?p=105 for more details.

  

  If you need to transfer email data from Outlook, Outport (http://outport.sourceforge.net/) might help. See http://p-s.co.nz/wordpress/?p=105 for more details.

  

  Web Bookmarks (intermediate)

  

  Export the bookmarks as HTML, and import them as HTML. If the user previously had Firefox 3 on the Windows machine, you could shift the bookmarks file places.sqlite instead. I am not sure if these two approaches are 100% equivalent.

  

  Misc

  

  Restricted Extras (beginner)

  

  Running the command sudo apt-get install ubuntu-restricted-extras will install Adobe Flash Player, the Java Runtime Environment (JRE), a set of Microsoft Fonts, various multimedia codecs, mp3-compatible encoding, FFMpeg, extra Gstreamer codecs, the package for DVD decoding, and the unrar archiver (see http://p-s.co.nz/wordpress/?p=330). NB: some countries have restrictive IP laws, so be careful to act legally, depending on where you live.

  

  Remote Desktop (advanced)

  

  Providing support to relatives is a lot easier when you can login to their computer remotely. Sometimes you will just want the command line (much faster), and other times you will want to visually interact with their Desktop using your mouse and keyboard (you can see the user's situation more easily). If both machines run Ubuntu, you can set up GUI access using Vinagre (below). For more details see http://p-s.co.nz/wordpress/?p=275.

  

  Thunderbird's LookOut Addon to Handle winmail.dat (beginner)

  

  Once in a while you may receive an email with an attachment called “winmail.dat”. How do you open it? Use the LookOut addon for Thunderbird: https://addons.mozilla.org/en-US/thunderbird/addon/4433. Avoid problems down the track by installing this addon. More background at http://p-s.co.nz/wordpress/?p=222.

  

  Conclusion

  

  Transferring files and settings is not always for the faint of heart, but it is achievable in a reasonable amount of time. Just be sure not to do it under time pressure. And remember – a full backup equals peace of mind.


  

  



  How To - Create A MAME Machine


  Written by Ronnie Tucker


  MAME is an application called Multiple Arcade Machine Emulator. In short, you give it ROMs from old arcade machines, and it plays them. MAME itself isn’t so friendly to use, or look at, so most people use a ‘front end’ application to allow you easy access to your ROMs. I’m using Ubuntu 8.10 for the OS, and will use Wahcade as the face of MAME. My idea is to have my old PC connected to my TV using the video card's TV-out socket.

  

  Installing Ubuntu

  

  Getting Ubuntu on to a PC is simple. Well, normally it is. But since I’m not using a monitor, Ubuntu couldn’t decide on a resolution, but the all-new, singing-and-dancing, bullet-proof X came to the rescue, and let me (at least) load Ubuntu with a low-resolution (800 x 600) which was enough to let me get going.

  

  TIP: If you are going to use the PC for only MAME then it’s probably best to tick the ‘auto-login’ box in step 5 of the Ubuntu installation. You’ll see why at the end of this article.

  

  With Ubuntu installed, it now needs to install all the latest updates, all 200+ of them! But once the updates are in place, I have access to the nVidia restricted drivers and can properly configure the video card for TV-out. Ubuntu is installed, but will it like my cheap Logic3 joypad? Time to find out. I installed the ‘joypad’ package, using Synaptic. From the command line I ran

  

  jstest /dev/input/js0

  

  (Note: some distros may use /dev/js0)

  

  which lets you test all the movements and buttons of the joypad:


  [image: ]


  This confirms that the joypad is detected, and fully working. Excellent!

  

  MAME!

  

  Now to install SDLmame. The website at http://wallyweek.altervista.org/ has a .deb file for download. Just click the appropriate link, and, when Firefox pops up to ask if you want to save the file, it also has an option to open the file in Gdebi. I use this option as it saves time by downloading and installing it with just that one click:


  [image: ]


  It’s the exact same idea with downloading Wahcade: http://www.anti-particle.com/wahcade.shtml

  

  With SDLmame and Wahcade installed, we’re ready to rock!

  

  /Home On The Range

  

  In your /home directory, create a directory called ‘emulators’; inside that, create one called ‘mame’, and, inside that, create one called ‘roms’. This is the default set of directories for Wahcade and simplifies the configuration of it.


  [image: ]


  Set-up

  

  If you check your Applications > Games menu, you’ll see some entries for Wahcade. We want to load the set-up application for the moment. The only things we need to edit are: in the Emulators tab (left), click the List Generation drop-down, click the browse button, and give it the roms directory (/home/yourname/emulators/mame/roms)

  

  In the MAME Only tab, click the button to generate a list of your ROMs:


  [image: ]


  And finally, the Keys tab. Maybe you won’t have to edit anything in here, but I had to tick the box to enable my joypad to be used in Wahcade for selecting ROMs:
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  Last thing to configure is SDLmame itself. It needs to know where your ROMs are stashed too. So' in a terminal, run:

  

  sudo gedit /etc/sdlmame/mame.ini

  

  Where it says rompath, paste/type in the ROMs directory (same one you gave to Wahcade)
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  Time to give it a whirl! Go to Applications > Games and load Wahcade!
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  The default Wahcade theme is quite garish, but others can be downloaded from various sites. I even created a simple MAME layout (left) for Wahcade:


  [image: ]


  http://ronnietucker.co.uk/mame/polaroid_1024.zip

  

  The reason to make Ubuntu auto-login is that you can go to System > Preferences > Sessions' and add Wahcade to the startup. This means your mean MAME machine would load up Ubuntu, log you in, and load up Wahcade for you. I do not recommend doing auto-login if your machine is to be used for anything else! Not only that, but Wahcade can also act as a front-end for most emulators, so in reality you could have this one front-end for all your emulators, and even have different Wahcade themes for each emulator!


  

  



  Write For Full Circle


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives - Kubuntu, Xubuntu,Lubuntu, etc.

  Write your article in whichever software you choose - I would recommend LibreOffice. But, please spell and grammar-check it!


  The Official Full Circle Style Guidecan be read at:


  http://url.fullcirclemagazine.org/75d471


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.


  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!


  FOR REVIEWS:


  Games/Applications


  When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary - with positive and negative points

  


  Hardware


  When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary - with positive and negative points

  


  You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.


  

  



  My Story

  Grandma Goes Shopping With Ubuntu


  Written by Alan Cocks
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  Irene, twice a great-grandmother, who had never used a computer before in her life. ‘I went to a computer class today. How do I use your father’s computer?’ This came out of the blue, and was the last thing we had expected.

  

  Irene, aged 88, was a hairdresser in her early years, then had a busy family life with young children, and never learned to drive. She now lives on the outskirts of a small town on the UK east coast, without fast transport links. Being widowed a year ago, she naturally felt very isolated and dependent on others. Her family is supportive, although they live many hours away.

  

  Lifts from friends, taxis, or local community transport, walking short distances in good weather, and even local buses, are all used sometimes to get about. Irene has suffered falls, on one occasion breaking a hip, so that even though she is quite prepared to make efforts, travel decisions, including for shopping, are made with some care.

  

  When her technically-minded husband was alive, he occasionally used an old computer for printing lists. Irene never used it herself. When, sadly, she found herself on her own, the computer remained unused.

  

  But desperation turned Irene’s thoughts towards the computer. To the great surprise of her family, who are all computer literate, Irene informed them that she was attending computer classes in a local adult class. Surprise is an understatement. The motive was soon clear: shopping.

  

  The course she had found locally, and joined, was for two hours twice a week – a foundation course in computing.

  

  Irene said "The first time I went, there was a big screen on the wall; we didn’t touch a PC; I went to two more lessons; I was typing out columns and paragraphs of text from a book; I did not even learn how to turn a computer on or off; I do not think I learned anything."

  

  Irene was clear that she wanted to do shopping online, and the teacher explained that this course was not suitable for that. The teacher said she would try to get Irene into a particular six-week course, although Irene says she heard nothing more. Irene left the course, and looks back on it saying it was a ‘waste of time’.

  

  By this time her family had got over their surprise about the turn of events, and not knowing where it might all lead, they had decided that the ancient computer her husband had used was not good for a novice who wanted to do online shopping.

  

  A family member had recently been given a discarded computer from a friend, and this computer was prepared for Irene’s use. Irene also got connected to broadband Internet, an activity which revealed an interesting 'catch 22' situation where communication, letters, passwords, and emails were expected to be dealt with by the elderly novice householder, not by another person (a relative) living on the other side of the country who wanted to make all the arrangements. It was resolved, thankfully, with the help of some common sense and understanding by the Internet Service Provider (ISP).

  

  The family are users of Ubuntu Linux, and also had a lot of experience with helping vulnerable novices, so Ubuntu was judged ideal in terms of ease of use and dependable security.

  

  The broadband connection and the computer were set up during the next family visit. Things were easily arranged so that there was a user account appropriate for what Irene needed, and that the administration of the computer was well protected.

  

  Menus were also easily trimmed to contain only useful items, and the display resolution and font sizes were set to be suitable for a user who did not always wear glasses, even when needed.

  

  The area is served by one of the big supermarket chains for delivery of online shopping. An account was registered.

  

  The computer, broadband unit, speakers, desk lamp, etc. were connected from a single mains wall socket, which would be turned off when not in use. The Web browser (Firefox) on the computer was arranged to start up automatically when the computer started up, and to have as its home page the supermarket shopping site.

  

  After the original activity of installing the equipment and setting up, time allowed only a couple of hours for Irene to have one-to-one instruction for her first ever online-shopping experience. It had been hoped that this would be a trial shop of only a couple of items.

  

  However, two hours and two-dozen items later, Irene was shepherded though the ‘Shopping Delivery slot’ calendar, and then the ‘Checkout’ sign off. She had survived the unfamiliarity, the searches, the unpractised novice wandering cursor, and the brutal formality of the checkout, all successfully.

  

  The shopping delivery arrived on schedule in a couple of days, to the delight of all concerned.

  

  Some days later, a bit of family remote support was needed to help with Irene getting her next order through the checkout successfully. It turned out that the entry field which needed the credit card number was being given the text name of the bank instead. This confusion was soon cleared up, and another successful delivery was on its way.

  

  One unexpected bonus Irene noticed with online shopping was – Ice Cream! Online shopping resulted in delivery of ice cream straight from a freezer to the door.

  

  The following week, the checkout activity again did not go smoothly, and the shopping basket stayed full, refusing to get through the checkout. The family later learned that Irene had then decided to use the telephone help line shown on the shopping site to sort things out. With indomitable persistence, the help line was phoned four times in different ways and combinations until she got through to someone who understood the problem, who could see her full shopping basket, and could accept the credit-card number over the phone. Another successful delivery. And congratulations for using the helpline successfully!

  

  Around this time, Irene was in conversation with another person who had been going to computer classes for two years. He was pleased to say he could now manipulate a printer font to be upside down. Irene asked if he could do online shopping. "No" he replied. "What’s the good of that then?" Irene asked.

  

  About a week later, Irene’s next shopping event went smoothly with no outside support needed. A real first!

  

  In the space of about four weeks, Irene had graduated to independence for her online grocery shopping in the alien world of computers and online shopping. This had been with remarkably little help, because although family support was available, it was by phone or remote help on request.

  

  Irene’s skills with the mouse needed as much practice as possible, and a good way to get enjoyable exercise has been to play an on-screen game such as Mahjongg. The rules were explained over the phone.

  

  The next family visit to Irene was not long after, and it happened that Irene had been considering making an existing spare room into a more comfortable bedroom, replacing an old bed. Her daughter suggested using the broadband-connected computer to buy – not groceries this time – but a bed.

  

  It would save at least one lengthy round-trip to the nearest large town, and would hopefully offer a more convenient choice.

  

  With the experienced help of her daughter, Irene now saw further benefit from having a broadband Internet connection. Choosing a reliable retailer came first, then identifying a suitable replacement bed, and, finally, deciding and arranging delivery – all when sitting comfortably with her daughter, and with a cup of tea.

  

  The bed was delivered four days later. Irene was impressed.

  

  She is going from strength to strength with her confidence in using the computer. She can now mostly do what she wants – shopping on her own and even checking her email. Having the computer and the basic skills has helped a lot, and she says it has "brought my independence back".

  

  Technical stuff:

  The computer is a recycled gift – tower, Tiny PC Pentium III 500 MHz, 384MB RAM, 20GB HD, CD ROM.

  Monitor is CRT 17 inch.

  Modem/router is Netgear DG834GT, wireless turned off.

  Broadband is 2MB, ISP is UKOnline.net, with modem router. (Lite package).

  Operating System is Ubuntu 8.04 LTS.

  User account – non admin, reduced menus, panels and menus locked.

  Web browser is Firefox.

  Email client is Thunderbird.

  Remote help facility is via Remote Desktop (VNC) through secure shell tunnel (ssh).

  Dynamic DNS used to facilitate secure remote access connection. (Free account).

  

  Further reading:

  Digital Unite

  http://digitalunite.com/

  Helping Older People Unleash their Digital Talents!


  

  



  My Story

  Translating FCM To Chinese


  Written by Jim Hu


  It was July 2007, and I had just finished my University entrance exam, was enjoying my free time at home, and began to try Ubuntu. I'd tried to use Ubuntu before, but it ended in failure. It was not compatible with my PPPoE network since, according to my ISP, I have to set ‘service name’ before I can connect. Pppoeconf just couldn't handle this, so, during my summer holiday, I bought a router and was able to connect to the Internet through Ubuntu. After that, I began my adventure with Ubuntu.

  

  After installing the system, strong curiosity arose. After glancing at the Chinese Ubuntu Wiki, I started to search for Chinese magazines which were mainly about Linux. As we all know, magazines publish every month so that we can stay up to date from their news. At that time, I found a magazine called Linuxer, but the magazine had ceased publication. I downloaded one issue anyway and was pretty disappointed. Not because the articles were bad, but the articles were too difficult to follow. I don't use Linux to be an expert, nor a hacker. The reason I use it is that I want a desktop environment. What I wanted to learn was some basic system management skills, or some interesting applications, as well as news about open source.

  

  So, I continued my search, and then I found Full Circle - a digital magazine focusing on Ubuntu. It had published its third issue. After I had finished reading it, I was not very satisfied with it. There were many articles for English users, which were not suitable for Chinese users. However, it was much better than Linuxer.

  

  I often visited the official site of Full Circle magazine, and, from reading comments there, I knew that lots of people wanted to have a Chinese translation of it. Of course that needed volunteers. Suddenly a thought rushed into my mind. Why couldn't I be that volunteer? I was frightened by that thought, since I was only a senior middle school graduate, and was never taught how to translate English into Chinese.

  

  It was the 23rd of July when I started my translation, and it was at this time the Full Circle Chinese translation team was created. I checked the Chinese translation wiki page on the English wiki site, and it appeared that someone had already started the translation, and had created a table for organizing things, but, unfortunately, he didn't leave his contact details, and didn't finish translating a whole issue. I created another table under this which looked similar, and filled in the information regarding my own translation status.

  

  In fact, I was pretty embarrassed about the translation since most of the translation job was done in Windows, also because I wasn't very familiar with SCIM input method at that time, so it would take me much longer to input Chinese in Ubuntu than under Windows. Not only that, but I couldn't input Chinese characters into Scribus under Linux. Lack of Chinese support hindered me quite a bit.

  

  I spent one hour each day on translation. After about three weeks, I almost accomplished the translation task. Just before I finished, Stickto contacted me and asked if he could offer any help. A volunteer is definitely welcome - whenever! At last, we finished the translation.

  

  Then, I had to solve another serious problem: Scribus. As mentioned before, Scribus has a lack of CJK support, so I couldn't input any Chinese characters into its story editor, but after a lot of research work, I finally found a way to input Chinese. The only way to do it was to paste the Chinese into the story editor under Windows. Though we still couldn't operate without commercial software, it was better than nothing. In my opinion, Scribus is not easy to use. I read the Scribus series in past issues of Full Circle carefully, and successfully managed to do the editing.
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  On 27th of August, the first Chinese edition of Full Circle was published. I passed this news to Linuxtoy.org, and the editor there helped me announce the news to the public (above). In fact, looking back at that first Chinese issue, the translation is really quite bad. In the comments below the news release, a lot of people complained about mispronounced characters, and the glossary, but the acknowledgements really cheered me up.

  

  By September that year, I started my college life, so devoting one hour every day to translation work was not practical. When I was about to give up, Lyper, Gwok and Mike Huang wanted to join the team, and that made it possible to continue the translation since I didn't have to spend so much time on it.
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  The team had grown and we needed to find a way to co-operate. We looked at what other translation teams did, and decided to do the translation using Google Docs. In order to keep in touch with other translators, we also created a Google Group and used it as a forum - http://groups.google.com/group/FCCTT.

  

  At the end of September, the second issue of the Chinese edition, Issue #4, was released. We now had over ten translators, and new volunteers just kept joining. Because of this, we divided our work into translation and review. We also started to add member's information to the English wiki page, but, to some extent, visiting that wiki was a nightmare. So, we transferred our wiki page to the Ubuntu-CN wiki. After a few days, when I revisited it, I was shocked. It had almost become a small website on its own. It had perfect content, and a very convenient navigation bar. Thanks to Lyper for her great job - http://wiki.ubuntu.org.cn/FC.
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  The open source community didn't let me down. After upgrading Scribus to 1.3.3.11, it could finally handle Chinese characters in Linux! Since Issue #6, we were proud to announce, the Chinese version of Full Circle magazine has been 100% open source, from OS to fonts.

  

  Time passed quickly. We had almost finished Issue #7 when I received an email from MrDrake. He came from Hong Kong and wanted to translate our Simplified Chinese version of Full Circle into Traditional Chinese. In mainland China, Singapore, Malaysia and Thailand, people use Simplified Chinese, but people in Taiwan, Hong Kong and Macao use Traditional Chinese. Of course we were glad to release both Simplified and Traditional Chinese versions of the magazine. That's when we started the Traditional Chinese Translation Team which is part of the Chinese Team. And, since then, we were able to release both Chinese translations at the same time. We really appreciate those volunteers from Hong Kong and Taiwan.

  

  We established a website, at the time we released Issue #11, using Google Sites. It really is awesome. You don't need to know anything about HTML, but you can make a really nice Website with it. The release page on the Google Groups moved to the Google Site. Now, we had our own official website!
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  Though the team grew quickly, some problems arose. When someone wishes to become a member of the translation team, we don't require that he or she must have passed Band 6 English test or something like that, the will is enough. As you can see, we had to face two problems: the first was that the quality of the translation was not as high, since anyone can join the team. The second problem was that when I assigned an article to someone, he or she may not finish the translation in time. So, we reformed the translation team. Still, anybody could become a translator, but those who did the review work were the 'elite' of the team, so to speak.

  

  Because of some personal affairs, I have to leave the translation team. After one month of hand over, Michael will continue my job. He is new to the team, but I can see his passion. His future plan is so great that it makes me think that leaving the team may be a mistake. However, people come and people go. A team should not be disbanded because one of them is quitting. I sincerely hope that the team becomes better under his lead.

  

  That's the story of my translation life. There's no cliffhanger, no heart break. If you want to ask me which is the hardest part of the whole thing, I say that it is the beginning. It may be tough when you start the project, but after you start it, people in the same boat will keep coming!


  

  



  My Opinion

  Is Ubuntu The Face Of Linux?


  Reading Issue 21 of Full Circle, I was pleased to see Marc Coleman's "My Opinion" address an issue that has bothered me for some time. I am new to Linux, having received an Acer Aspire One with Linux installed as a Christmas present from my wife and family. Since its arrival, I have spent a lot of time learning how to use the terminal to get things done: removing the terrible interface and installing xfce, for example. Being a Windows user, I have shied away from Linux in the past due to its image as an OS for serious "tech heads", and the common belief that, if you want a "point and click" OS, then any Linux distro is to be avoided.

  

  In recent years I have become tired of Microsoft's products and product failures, to the point where I now have Ubuntu installed on my spare PC. It works with no problems, but as Marc mentioned, if there is a problem, and you dare to ask a question, the reply is often not an answer but a rebuke - because you haven't asked the question correctly. My favourite answer is "that's easy! Just use the sudo command," which is of little use if you don't know what to type after it!

  

  Maybe I'm being overly critical, but for a novice the whole Linux experience can be a bit tricky. I'm certainly not new to computing, having started with home computers on a Commodore 64, Atari ST, etc., but nowadays I don't want to have to use the terminal to get things done: point and click will do nicely. Marc passed comment on the Linux/Ubuntu argument, and I agree entirely. Maybe Ubuntu is changing the face of Linux with extended GUIs, but this is not only what many users want, but need.

  

  In my spare time I teach basic IT skills to people who are hearing-impaired: how to use email, write a letter, save files, etc., all of which are done using XP. Even XP is too complicated for some of them, so a move to Linux and the terminal would be like asking them to use the command prompt in Windows. As much fun as hacking is, it's also time-consuming and, like it or not, people these days expect performance at the touch of a button so they can get on with their busy lives.

  

  For far too long, Windows in one form or another has been shipped with most new PCs, and the public has gotten used to its "point and click" design and the "insert disc and press install" ease-of-use. I really can't imagine many people would be thrilled when it comes to using the repositories to install a basic program. So, maybe Ubuntu is becoming the acceptable face of Linux distros, but is this so bad? From what I've read on other tech forums, most Linux users agree that Microsoft's monopoly shouldn't go unchallenged, so, when a Linux distro becomes popular, this should be applauded, and the creators of the distro should be given the praise they deserve.


  

  



  Book Review

  Ubuntu Unleashed


  Written by Ronnie Tucker


  P/back: 864 pages

  Publisher: Sams; 4Edition (July 20, 2008)

  ISBN: 9780672329937

  

  It is certainly comprehensive, can't hold that against Ubuntu Unleashed. This is the 2008 Edition - still valid today, in 2009, since it is based on Ubuntu 8.04. Free with the book is an Ubuntu 8.04 DVD, which will no doubt come in handy for many readers. The book starts off by discussing the installation and configuration of Ubuntu, going so far as to talk, briefly, about GNOME, KDE and X. Even though the book is aimed squarely at Ubuntu (with GNOME), it still gives some mention to KDE and its applications. Then some sections on various internet applications (instant messaging, IRC, and the like), OpenOffice.org, GIMP, burning CD/DVDs (burning a DVD from the command line, anyone?), then games. Not a lot is said about games, but it does mention the usual Quake/Doom/UT2004 culprits, and, credit where it's due, it even gives a few pages to Cedega in trying to lure Windows gamers to Linux. Phew! That's a lot of information, and that's only the first third of the book!

  

  After the more introductory chapters, the going gets tough with user management (via command line), shell scripting, system monitoring, networking, and remote access with SSH, even Telnet. It's inevitable, with a tome this size, that it would touch on server stuff. Not only does it advise on how best to set up a server, but it details the set up of things like Apache Web Server, even discussing Virtual Hosting. Also included are Remote File Serving with FTP, and Handling Electronic Mail (that's e-mail to you and me). Finally, the book touches on programming Linux with Perl, Python, PHP Scripts, Mono and C/C++.

  

  And the bad? First and foremost, I think, is the 'Free Upgrade to Ubuntu 8.10' that's emblazoned across the cover. Of course it's free, it's Ubuntu! What they really mean is that you can register the book on their website and receive a free upgrade kit from the publishers. In the chapter on backups, it talks about tapes – does anyone still use tapes? Mentioning RhythmBox for music, but not mentioning Amarok? – a glaring omission. As is the lack of K3B for burning CD/DVDs. But, in saying that, it's all about personal choice. Something Linux is excellent at.

  

  This is a mighty tome indeed, no doubt about it. The first third of the book is an easy read for the beginner, while the remainder commendably contains enough information for the new user to learn pretty much everything they'll need to know about using Ubuntu.

  

  Competition

  

  This month we have three copies of Ubuntu Unleashed 2008 Edition to be won! To win a copy, answer this simple question:

  

  Q: Which music playing application does the book not mention?

  

  Email your answer to: competition@fullcirclemagazine.org. All entries must be in by Fri. 22nd May 2009, and the winners will be announced in FCM#25. Good luck!

  

  Full Circle would like to thank SAMS for their generosity in giving us three copies for this competition.


  

  



  MOTU - James Westby


  Taken from behindmotu.wordpress.com
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  Age: 24

  Location: Bristol, UK

  IRC Nick: james_w

  

  How long have you used Linux, and what was your first distro?

  

  I’ve been using Linux for around 4 years now, starting with Debian.

  

  How long have you been using Ubuntu?

  

  I’ve been using Ubuntu for around 9 months.

  

  When did you get involved with the MOTU team, and how?

  

  I got involved with MOTU after UDS Hardy in Boston. I was invited to UDS as an upstream developer, and got to know a few MOTUs there. After that, I started working on some Ubuntu development, mainly on things that benefited Ubuntu and Debian, as I was involved a little with Debian development. I have been concentrating more on Ubuntu for a while now, as the community was more welcoming, and it’s easier to find a place for yourself as it is smaller.

  

  What helped you learn packaging and how Ubuntu teams work?

  

  I learnt packaging while working in Debian. It was mainly a case of getting stuck in, and googling a lot when I got stuck. I learnt a bit about Ubuntu from the UDS, especially from Daniel Holbach, Stefan Potyra, and Reinhard Tartler. The rest was just looking at the wiki, and mainly asking questions.

  

  What’s your favorite part of working with the MOTU?

  

  Two things really, firstly the community – it’s a pleasure to work with MOTU and other people involved with Ubuntu development. Secondly, making a great distribution even better is a great feeling.

  

  Any advice for people wanting to help out MOTU?

  

  Just get stuck in. Find a bug that annoys you in a package you use, and try to fix it. Often, this is more about looking in the right places, and talking to the right people, than knowing how to code. Also, ask questions – people will help when they can, and, if you don’t get a response, then it’s probably a hard question, and fixing it will be even more satisfying.

  

  Are you involved with any local Linux/Ubuntu groups?

  

  I’m a little involved with Ubuntu UK, but I don’t do as much as I would like.

  

  What are you going to focus on in Intrepid?

  

  For the little that is left, I’m going to focus mainly on fixing as many bugs as possible. I’m also going to be looking for the most important things to focus on for Jaunty.

  

  What do you do in your other spare time?

  

  Drink cider and dance like a fool.


  

  



  Letters


  I'm a linux user since Slackware 3.5 (or something like that), but a couple of months ago, I reinstalled Windows XP on my DELL Inspiron 1501 (AMD X2, 1GB, 15", ATI) because of a very annoying bug in Ubuntu. At random times, the AltGr key would become disabled. As I read around the internet, this is not an Ubuntu problem, but a kernel one. As I live in the Internet (figuratively speaking) imagine the problem if I can't write the @ symbol because of this bug. I'm very sad about leaving Linux (and Ubuntu, my prefered distro), but I need to work. I still use Linux on servers though.

  

  Gabriel Drach


  


  

  HOW IS FCM CREATED?

  

  Page 3 of each issue shows that three apps are used, but it would be a great to know how these apps are used to put together an issue of Full Circle. It would be terrific to get a step-by-step tutorial of how we too can use Ubuntu and its free applications to make a great looking newsletter.

  

  Jason Allen

  

  Ed: If there's enough interest then I could certainly write a How-To on using FOSS to create a newsletter, or magazine. The applications are used by us to edit/write articles (OpenOffice.org), graphics (GIMP) and for creating the final PDF (Scribus), but we also use a wiki to let the proofreaders access the latest version of the articles, before they are used in the Scribus layout.


  


  

  ONE STEP AT A TIME

  

  My daughter works for a local newspaper, running Windows 2000 on her old Compaq laptop. Her boot time was at least twenty-five minutes, not to mention how long it took just to open an app. Finally she'd had enough! So I walked her through the installation of Xubuntu on her computer. The only hunting we had to do for her was Brother printer drivers, which was solved by going to Brother's website.

  

  She had a few bumps in the road the first two weeks but she caught on fast. Now she likes it and my son-in-law said that if he'd known it was so easy he would have tried it much earlier.

  

  Now a friend of his is trying Ubuntu. Success comes with one step at a time.

  

  Tom Lombardy


  


  

  BLACK SCREEN & BLINKING CURSOR

  

  I, and a couple of friends, have tried several different Linux distros and our consensus is that Linux is very buggy and unreliable. I don't know how many times I've updated an install only to see a black screen, and a blinking cursor on reboot, or the screen resolution reduced to 640x480. This must be the reason Linux on the desktop is less than 1%. Am I wrong?

  

  whitlockmark


  


  

  GAMING SURVEY

  

  I'm not sure the gaming survey in Issue 23 is accurate in the way it presents information. 90% of those surveyed want to buy native Linux games--but even 90% of the Linux community isn't very much at all--about equal to one or two percent of the Windows community. As much as I like Linux and games, I think that Linux needs more marketshare before it becomes a viable target for game companies.

  

  Timmy Macdonald


  


  

  CORRECTIONS TO FCM#23

  

  In response to Question #2: A separate /home partition has not been necessary in a while. Ubuntu's installers do not remove directories named "home" when installing. Also, if you just get an alternate CD instead of a live CD, you can upgrade using it.

  

  In response to Question #3: A swap partition is necessary if you want to be able to hibernate. The swap partition needs to be at least the size of your RAM memory.

  

  Mackenzie Morgan


  


  

  TELL ME MORE!

  

  First of all I love your magazine, too bad I did not hear about it earlier. It would have helped me, as a rank beginner who did not even touch Linux prior to just over a year ago when I came looking for an OS for a laptop I had bought. I wish you would cover more newbie basics as they were my biggest headache! Namely; Flash, Java, and how to get media to play. This is far from easy, and took me more than six months before everything, well nearly everything, played correctly. Also I would love to see more articles on what is out there. I am a member of Ubuntu Forums and every so often someone brings everyone's attention to a piece of software I had frankly never heard of before, and then there are those games found at getdeb.net. Why haven't they been reviewed?

  

  Also I would love to see someone do an actual article on why more and more software companies are making apps available on Linux. For example: Acroreader is now a .deb file, as is Flash 10. I even saw a version of Real Player!

  

  Ed Nelson

  

  Ed: The simple answer to your question, regarding certain articles, is that we rely on reader input. Just as this letters page would not exist without letters, the magazine needs people to write articles for it. If an article isn't sent in, we can't print it. So come on people, get writing!


  

  



  Ubuntu Women


  Written by Myriam Schweingruber
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  Myriam Schweingruber: Hi, please tell us something about you first.

  

  Elizabeth Krumbach: My name is Elizabeth Krumbach. I live just outside of Philadelphia in the US, and work as a Debian and Ubuntu Systems Administrator for a local Linux-centric technology services provider.

  

  MS: How did you train to become a sys-admin?

  

  EK: I was primarily self-taught - taking on projects that looked fun, and getting involved with the community. From there I was hired as a Junior Sysadmin and learned in a more "trial by fire" environment.

  

  MS: This sounds impressive, did you follow any LPI courses or similar?

  

  EK: Nope, essentially I'd just find a project I want to do, find documentation in books or online on how to do it, and ask people in the community along the way if I need help. It's surprising how much documentation is really out there; there are very few tasks I encounter that haven't been completed and documented by someone before me.

  

  MS: True, I guess many people become Linux professionals that way, as the openness isn't limited to the source code.

  

  EK: Absolutely, and the times I do find something that isn't well-documented and I have to do the research myself, I publish my own how-to and put it online.

  

  MS: A great way to give back! How and when did you first come in touch with Free Software/Ubuntu?

  

  EK: I started using Linux in early 2002. The first project I was involved with was bitlbee.org in 2005 - when I joined their IRC channel, and learned through discussion that they needed their quickstart documentation rewritten, I volunteered. As for Ubuntu, I had been using Debian since 2002. Ubuntu came up on my radar when I was giving new distros a try. Shortly after trying it I installed it permanently on my laptop. There was no turning back! I got involved via Ubuntu Women in early 2006.

  

  MS: In what project(s) are you active?

  

  EK: I do a lot of community work with Ubuntu, and maintain a couple of packages for Debian, including being part of the Debian LedgerSMB team. I also coordinate the Philadelphia Linux Users Group and the Philadelphia LinuxChix chapter.

  

  MS: How long have you been a Debian package maintainer?

  

  EK: I contributed my first package, dglog, in 2006.

  

  MS: What do you like most about Ubuntu?

  

  EK: The fantastic community. It's really reshaped my impressions of what F/OSS projects could achieve and be. Not only is it wildly successful, but it's friendly and a real delight to be part of. As for the OS itself? It's the best desktop OS I've ever used, stable, configurable, and up to date.

  

  MS: As an active member of your LoCo Team, do you have tips how to motivate people to participate more actively?

  

  EK: I believe the key is letting people know that any contribution is useful and important, and that no experience is required to get involved. Simply showing up for an event to support your fellow team members is more helpful than most people believe.

  

  MS: You are also involved with the Ubuntu Classroom Project, could you tell us more about it?

  

  EK: Sure, Ubuntu Classroom is a central place where projects within Ubuntu can come to host IRC-based classes to show others in the community how to do certain tasks usually pertaining to their project. Classroom is also partnered with the Beginners Team to host a series of classes that cover just about any topic in Ubuntu that people request classes for.

  

  MS: Oh, there is a Beginners Team?

  

  EK: Yep! https://wiki.ubuntu.com/BeginnersTeam

  

  MS: This is awesome, Ubuntu really covers all fields!

  

  EK: Sure does.

  

  MS: Back to your Debian work, could you tell us more about your involvement?

  

  EK: I am the co-maintainer for WebCalendar, and recently have been putting in a lot of time with the Debian LedgerSMB project, working to get LedgerSMB into the next Debian release.

  

  MS: What exactly is LedgerSMB?

  

  EK: It's a web-based double entry accounting system, the "SMB" stands for "Small Medium Business"

  

  MS: Is it already in some Debian repository?

  

  EK: No, the project that it forked from, SQL-Ledger, is in Debian and Ubuntu. LedgerSMB is a more open, community-driven project that tends to accept patches and implement features more readily so we'd like to see it included.

  

  MS: Do you plan to package LedgerSMB for Ubuntu once it is ready?

  

  EK: The plan is to package it for Debian and then have Ubuntu sync it from unstable, but if more folks choose to step up and help out I'd be willing to package it for Ubuntu directly (a LP bug exists to do just that: 150374)

  

  MS: So working for Debian is in fact working for Ubuntu upstream!

  

  EK: Yep!

  

  MS: Thank you for the interview!


  

  



  Ubuntu Games


  Written by Edward Hewitt


  
    GAME NEWS

    

    • Battle for Wesnoth 1.6 is out ‒ It comes with a new campaign called The Legend of Wesmere, new graphics, and improved multiplayer.

    


    [image: ]


    • Gfire 0.8.0 is released – The latest release is the biggest release yet. It offers major new features such as Group Chat and Improved game detection.

    


    [image: ]

  


  



  World of Goo
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  World of Goo has taken the gaming industry by storm. This cute puzzle game has been incredibly popular for the Nintendo Wii and Windows, now it has reached Linux. I would like to thank 2D Boy for supplying a review copy of the game.

  

  Straight off the bat, this game is excellent. It's unique, fun, and loved by everyone. World of Goo is basically a puzzle game which uses physics: you build structures out of Goo balls. You need to get these goo balls to a pipe. In total, there are 48 unique levels split across 5 chapters. What makes these levels unique is how every level looks very different, and has its own soundtrack. This gives the game a different atmosphere and art style, which keeps it fresh.

  

  At the start of every level, you are given a certain number of goo balls. These balls have two purposes: first, to be able to build a structure to the pipe, and, second, to get this goo up the pipe. You need to have a certain amount of goo which must go up the pipe, so you have to be careful not to waste them all on the structure. It can be quite annoying - after building a complex structure to the pipe, you may then not have enough goo! The first few levels are simple enough, but quickly the levels become very complex and hard. When you first see some of the harder levels, it looks like it's virtually impossible. You need to use the right amount of goo in the right places to complete the level. If you use too many goo balls on one side or the other, it can easily topple over. There are plenty of levels to complete, many which will take quite a few attempts until you understand what you have to do. Once you have finished the puzzles, there is an online mode, called World of Goo Corporation. The aim of the game is to build the tallest goo tower in the world. You use the goo balls which you collect from the chapters to build the tower, which is uploaded to the World of Goo servers. When you build the tower, you are able to see the height of other towers (currently the tallest tower is 50.82m high!).

  

  Without a doubt, you must buy this game! There is a demo, but you get to see only about a sixth of the game, and it does not do this game justice. I have shown people at my school this game, and they loved it as soon as they saw it. They found it enjoyable and funny how the Goo balls flop about the place. World of Goo is one of those games which is unknown to the mass market who want to play GTA4 or Call of Duty, but it is a real gem of a game. Simply, World of Goo is a must-have game for Linux Gamers!

  

  You can download and purchase this game from http://2dboy.com for US$20. They provide a .deb file which works with Ubuntu.

  

  System Requirements

  

  • 1GHz CPU

  • 512MB RAM

  • 100MB HDD Space

  • 3D Graphics Card


  

  



  Q & A


  Written by Tommy Alsemgeest


  
    	Q I've just purchased a new Minimac, and would like to know if there is any problem installing Ubuntu on it using boot camp?


    	A Unfortunately, I don't have a Mac to test this on, but apparently you use bootcamp to create a new partition, boot up the Ubuntu Live CD, use the partition editor to delete the last partition (the Windows one that you just created). Quit the partition editor, then start the installer, and, when asked where to install to, choose to install to the free space.


    	



    	Q When burning an .ISO file, do I need to burn to a data CD? Or will a music CD be OK?


    	A Ideally it should work on any blank CD. Just make sure you burn the file as an ISO, and not just burn the ISO file to the disc as a file.


    	



    	Q I currently run 8.10, when I update through my package manager, will I lose all my files? Secondly, in 9.04, I am hoping for better support for my Logitech Web cam STX - currently there is a known issue with this camera in 8.10. Lsusb for the web cam says:

    

    Bus 002 Device 003: ID 046d:08ad Logitech, Inc. QuickCam Communicate STX.


    	A When you upgrade to a new Ubuntu release through the update manager, all your files will remain, and programs will be upgraded. However, there is always a certain risk involved. The safest route is to backup your files, and do a clean install from the Live CD, or upgrade using the Alternate CD. For the Logitech webcam, there is a possible fix included in Jaunty (9.04).


    	



    	Q My question is about one thing that I'm trying to do to older machines to create an LTSP server. I work at a school, where I would like to implement it, but I cannot find a good tutorial to explain every step, and what to do when something goes wrong with the installation.


    	A There is a good how-to here: http://linux4dummies.wordpress.com/2007/06/29/ubuntu-ltsp-server/ and, if you have problems, search Google on the problem (accompanied with the words "ubuntu" and "LTSP"). If that returns no useful results, turn to Ubuntu Forums.


    	



    	Q I have a small Samba file/print sharing network up and running, but what I would like to do is to force the Samba share to be mounted as a specific drive letter in Windows. Is this possible without setting up DNS?


    	A In windows, you should be able to map the network drive (My Computer > Tools > Map Network Drive), and select the drive letter you want from there. Mapping it as a network drive should keep the same drive letter whenever it gets mounted.


    	



    	Q Does memtest86 shut down automatically when it's done?


    	A Memtest never finishes, it keeps testing your RAM. Once you've let it run for a reasonable amount of time (usually and hour or two will show up any defects), just exit the program.


    	

    


  


  My Desktop
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  On my laptop, I decided to play with the Dust theme, and a few widgets and fonts, to find something to convince my Mac friends to reconsider their choices. I'm running Cairo Clock, Avant Dock, and the Dust theme (with a few extra tweaks). I myself have been running Ubuntu since Feisty, and, while I have Debian, Fedora and Slackware machines in my house, I use Ubuntu the most. My laptop is a 2.0 GHz Sony Vaio with 1.25 GB of RAM and an integrated 32 MB Radeon 9200 graphics card.

  

  Shay Thompson
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  Dell Inspiron 530N (that came with Ubuntu 7.04 installed), currently running Ubuntu 8.10. Monitor: 1440 X 900 flat screen.

  

  Wallpaper: A combination of 5 photos taken from my apartment complex, stitched together using Hugin, then cropped and resized. You are looking at the Town of Fountain Hills, East, toward the mountains. Four Peaks is the one with clouds over it. On the right, the "green spike" is the fountain for which Fountain Hills is named. It's green because the picture was taken on St. Patrick's Day. The Team branding is an overlay on the original picture, created with Gimp of course. The colors are those of the Arizona State Flag.

  

  Window decoration: Crux, changing the colors to those of the desert: the red of some of the rocks around Red Rocks (Sedona), Arizona, and the tan of the sand/gravel used in the landscaping out here.

  

  Craig A. Eddy
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  A few notes about the desktop I am using: I combined two of my favorite images to create the graphic. GIMP was used to remove the background and other features of the glass Ubuntu logo, and make it transparent, and then scale it to fit in the water droplet area.

  

  Here are the settings and themes I am using:

  Controls - GTK2-Glossy_P, Cursors - Blueglass-xcursors-3D, gdm theme - Relaxing-water, Icons - nuovext, Splash theme - water_splash_2_rounded, Window borders - Alphacube-metacity, Gnome background - skyridge, Skydome picture - beautifulthings-1095739603.png, Firefox theme - firefox 3 linux 1.1, Desktop image is splash, combined with ubuntu-glass: http://hqwalls.blogspot.com/2007/09/glass-ubuntu-hq-wallpaper.html

  

  I also did a few tweaks with compiz to enhance some of my drop shadows and change some transparencies of menus and dropdowns, and I unchecked expand on the top panel to make it shrink to the center of the top of the screen.

  

  Martin G. Miller
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  I'm running 8.10, with Compiz Fusion and Emerald. The GTK theme is TechniX by TheRob - found at gnome-look.org and/or deviantart.com. The Emerald theme is Crapsta by TheRob, modified by myself with the buttons from Stanfield, both at gnome-look.org. As you can see, I have the Avant Window Navigator, the icons are Royal Blue - also from gnome-look.org. I also modified and am using TheRob's conkyrc script. I like to change my Desktop look every so often just because I can. I have been using Linux since 1996, and Ubuntu since 4.10. I usually upgrade with every new release - just to get the new features. I've tried both Kubuntu and Xubuntu, but I keep coming back to Gnome.

  

  Ed Hulett
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  Here is my lovely desktop. I'm running Ubuntu 8.10, and this is a compilation of 'screenlet' applications, Gnome 2.24, and all the wonderful things you can find at http://www.gnome-look.org/. As you can see by the meters on the desktop, this environment is too heavy for my laptop specs, so now I'm running Ubuntu with default settings. It's not bad! My laptop specs: HP NX6125, AMD Turion 64 1.8GHz, RAM 896, ATI Radeon 200M 128MB (shared). And, please, if it is possible, promote the magazine on the Ubuntu homepage, because it is a shame if even one ubuntu user doesn't know about Full Circle!

  

  Manolis Kaltsos
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  As a student in informatics, I spend most of my time around my computer. It encourages me to think twice about which wallpaper or icons I choose. The wallpaper has been downloaded from the Desktography Project. They have a yearly collection of refreshing wallpapers. The icons used are Gnome-Colors, and the theme is an old fork of Frozen. This all is shown using Compiz Fusion, Gnome, and Ubuntu 8.10 - on a Sony Vaio VGN-FE21H with 2GB SODIMM-RAM, and an Intel Centrino Duo clocking at 1.66 GHz.

  

  Michaël Vanderheeren
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  I am running Ubuntu 8.10 Remix on my Acer Aspire One (120GB Hard Drive). Boot-up time is around 30 seconds, and all the applications are very fast on this little netbook. I have it loaded up with a few extra applications, including VLC, Songbird, Gnome Do, as well as some applications for programming. The Remix display and layout took a little getting used to, but now I absolutely love it, and prefer it for these little netbooks. To set up your Acer Aspire One with Ubuntu or Ubuntu Remix, look here ‒ https://help.ubuntu.com/community/AspireOne.

  

  The theme that I am using is "Dust", which is my favorite and standard theme for all my Ubuntu computers. It can be found here ‒ https://wiki.ubuntu.com/Artwork/Incoming/DustTheme. The wallpaper is barely visible through the Remix display panel, but is from the Dark Wood Linux wallpaper pack from gnome-look.org. I also have a really nice and slick-looking non-default GDM that I found on DeviantArt, and thought was worth sharing (http://danrabbit.deviantart.com/art/Willwill-s-Intrepid-GDM-94051500).

  

  Simon Engelbert
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  I am running Intrepid Ibex on a Gateway GT5418E Desktop Computer, with an AMD Athlon X2 processor and onboard Nvidia. I am using Cairo Dock, compiz-fusion, and a customized Emerald theme. I've used Ubuntu since Edgy Eft, and, before that, used another Debian-based KDE-centric system.

  

  Personally, I love GNOME and the eye-candy and personal effects of Cairo Dock. I have also used AWN, but favor Cairo. The wallpaper is the Yaquina Head Lighthouse in Oregon, USA.

  

  Joseph A. Millikan


  

  



  Top 10

  The Best Of Top5, 2007-09


  Written by Andrew Min


  AstroMenace
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  http://www.viewizard.com/astromenace/index_linux.php

  

  While not the most famous on this list, AstroMenace is by far one of the best games I've ever played. It is, as you may have guessed, a space-shooter. In this 3D space-scroller, you navigate a ship around asteroids while destroying enemy ships. Sure, it sounds like just another side-scroller, and it would be, except for the stunning 3D graphics. (Now would be a good time to tell you that you need a super powerful graphics card and a ton of RAM.)

  

  To install AstroMenace in Ubuntu, you'll need to add a new repository. Full instructions are available at http://url.fullcirclemagazine.org/1de13a (scroll down to the apt repository section). After that, install the `astromenace` package.


  


  

  Extreme Tux Racer
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  http://www.extremetuxracer.com/

  

  Extreme Tux Racer is another extremely difficult and addictive game. Like Frozen Bubble, the premise seems absurdly easy: race down a hill collecting herrings. However, you need to get every single herring to win. Oh, one more thing: you can't go backwards! And don't forget about the slippery ice, the trees, the jumps, or the time limit.

  

  Extreme Tux Racer hasn't yet made it into the repositories. Luckily, you can download a .deb created by a user named Hamish. You can also install an older version known as Planet Penguin Racer using the package `planetpenguin-racer` in the `universe` repository.


  


  

  FreeCol
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  http://freecol.org/

  

  FreeCol is a terrific open-source clone of Sid Meier's turn-based strategy hit, Colonization (heavily based on Civilization). You start in 1492 as the Dutch, the British, the French, or the Spanish, and build up your colony by trading with natives, capturing enemy towns and settlements, and recruiting skilled (and unskilled) laborers. It even includes multiplayer for LAN or TCP/IP games.

  

  You can install FreeCol using the `freecol` package in the `universe` repositories.


  


  

  Gnome Blog


  [image: ]


  http://www.gnome.org/~seth/gnome-blog/

  

  If you like the simplicity of KBlogger, but use Gnome, give Gnome Blog a try. It's a simple Gnome Panel applet that, like KBlogger, focuses on simplicity and ease-of-use. It supports WYSIWYG editing, spell checking, images, and basic formatting. Protocols include Blogger, MetaWeblog (including Wordpress, Drupal, and Windows Live Spaces), Movable Type, and Pyblosxom.

  

  To get Gnome Blog, install the `gnome-blog package` from the `universe` repository. Then add the "Blog Entry Poster" to the Gnome panel by right-clicking on the panel, clicking "Add to Panel" and choosing "Blog Entry Poster."


  


  

  HandBrake
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  http://handbrake.fr/

  

  Originally developed for BeOS, Handbrake first gained prominence as an open-source DVD ripper for OS X. However, in early 2006, a group of hackers forked HandBrake and renamed it Media Fork. One of the new features added was a CLI port to Linux. A year later, the projects merged, and now, HandBrake is one of the most prominent rippers on Linux, especially after the recent GTK+ GUI for the Linux port.

  

  Unfortunately, it's not in the Ubuntu repositories yet. So, to install Handbrake, you'll need to use the official .deb at the download page.


  


  

  LMMS
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  http://lmms.sourceforge.net/

  

  LMMS (Linux MultiMedia Studio) is another great all-purpose sound editor. Similar to the commercial Cubase or FL Studio, LMMS combines a powerful synthesizer with a great tracker/sequencer program to create an amazing audio editor. With it, you can also capture input from MIDI keyboards, write music with a great song editor, add loops and beats, or use plugins for LADSPA and Cubase (with WINE). All wrapped into a powerful, yet easy to use, Qt-based GUI.

  

  To install LMMS, all you need to do is get the `lmms` package in the `universe` repository.


  


  

  Midori
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  http://midori.sourceforge.net/

  

  For those who liked Arora's fast, lightweight, WebKit-powered engine, but didn't like Qt, Midori is worth a go. Since it's WebKit, it's blazing fast. And it also has quite a few features - tabs, lots of interface customizability, proxies, and a very handy form filler. However, it still manages to stay light and unbloated - a lesson for many other browsers.... Note that, like Arora, it is definitely heavy alpha, so only the brave should install it.

  

  To install Midori, grab the `midori` package from the `universe` repository. You can also grab the `midori-dbg` package if you're having some problems debugging it.


  


  

  Tilda
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  http://tilda.sourceforge.net/wiki/index.php/Main_Page

  

  An oldie but goodie, Tilda was created by Tristan Sloughter (aka kungfooguru) in December 2004. Named after the tilde (~), this powerful terminal is modeled after the gaming terminals found in Quake and many of its derivatives. With a simple key combination, Tilda will gracefully slide down from the top of the screen, and present a full terminal. Hit the combination again, and the terminal quickly slides out of view, waiting in the background for another order. It even provides a multi-tabbed interface, so you can have multiple terminals running at the same time.

  

  To install Tilda, grab the `tilda` package from the `universe` repository. After installing, run:

  

  tilda -C

  

  to configure it.


  


  

  VirtualBox
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  http://www.virtualbox.org/

  

  This VM (virtual machine) application, owned by Sun Microsystems and created by a small company called innotek, is one of the most popular virtualization solutions for Ubuntu. It's the third most popular method to run Windows apps on Linux, according to DesktopLinux.com (trailing Wine, which is not an emulator/virtualizer, and VMWare, which is proprietary). There's good reason: it has a bevy of features, including snapshots, shared folders, RDP, ability to use host USB, and a lot of advanced hardware virtualization.

  

  There are two versions of VirtualBox. Installing the open-source edition is easy: just install the `virtualbox-ose` package in the `universe` repositories. If you want to install the enhanced but closed-source version, you'll need to visit the website and download the .deb.


  


  

  Wormux
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  http://www.wormux.org/

  

  Most of us have played the classic 1995 game Worms. It was an old side-scroller where you make worms blow each other up with rifles, bazookas, grenades, shotguns, Uzis, and Priceless Ming Vases. Well, although it still exists as a commercial series, a GPL spinoff known as Wormux has been released. Instead of worms, you fight with OSS mascots--Tux and Mozilla are two examples. But don't worry, the Holy Hand Grenade is still there.

  

  To install the latest stable version of Wormux, grab the `wormux` package in the `universe` repository.


  

  



  ﻿FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles and Full Circle is no exception. We need your Opinions, Desktops and Stories. We also need Reviews (games, apps & hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or suggestions, you may have.


  We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:



  http://wiki.ubuntu.com/UbuntuMagazine


  Please email your articles to:

  articles@fullcirclemagazine.org


  If you would like to submit news, email it to:

  news@fullcirclemagazine.org


  Send your comments or Linux experiences to:

  letters@fullcirclemagazine.org


  Hardware/software reviews should be sent to:

  reviews@fullcirclemagazine.org


  Questions for Q&A should go to:

  questions@fullcirclemagazine.org


  Desktop screens should be emailed to:

  misc@fullcirclemagazine.org


  ... or you can visit our forum via:

  misc@fullcirclemagazine.org


  Full Circle Team:


  Editor - Ronnie Tucker -

  ronnie@fullcirclemagazine.org


  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org


  Comms Mgr - Robert Clipsham -

  mrmonday@fullcirclemagazine.org


  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Editing & Proofreading:


  Mike Kennedy

  Lucas Westermann

  Gord Campbell


  Our thanks go out to Canonical, the many translation teams around the world and to Thorsten Wilms for the current Full Circle logo.
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